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Overview 
 

VLAN Manager is a tool that enables you to configure VLANs on a device using a graphical 
user interface (GUI) or by importing VLAN definitions from a file. 

Topics 

• Starting VLAN Manager  
• Main Window  
• Basic Operations  
• Menus  
• Device Support  

 
1 Overview 
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2 Starting VLAN Manager 
 

VLAN Manager can be started from Device Manager or from the command line. 
In a Windows environment, VLAN Manager can be started from the AlliedView-EMS 
program folder or from the Run command of the Start menu. 

You can start VLAN Manager from Device Manager by clicking on Tool > VLAN Manager 
on the main menu or by clicking on the VLAN Manager icon  on the toolbar. If Device 
Manager is connected to a device, target host information is automatically passed on to 
VLAN Manager so that the VLAN configuration of the device can be retrieved and displayed 
in VLAN Manager's main window. 

 
2 Starting VLAN Manager 
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3 Main Window 
 

When started, VLAN Manager displays one of the following windows, depending on how 
it is started. 

Topics: 

• Initial Window 
• VLAN Information Window 

 
3 Main Window 
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3.1 Initial Window 
 

If the target host is not specified, or if one or more connection parameters do not match 
what is configured on the host, the following window appears. 

Initial Window 

To specify a target host from this window, select File > Open. If the target host is a device 
model that is supported by VLAN Manager, the VLAN Information Window displaying the 
target host's VLAN configuration will appear.

 
3 Main Window 
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3.2 VLAN Information Window 
 

When a target host is specified and VLAN Manager recognizes it as a device model that 
it supports, the following window appears. 

VLAN Information Window 

The menu bar provides access to VLAN Manager's operations. 

The VLAN Information Window displays the VLAN configuration of the device being 
managed. Information is organized in a table format with each row representing one 
VLAN definition and each column representing one attribute of the VLAN. VLAN attributes 
displayed differ from one device series to another. Refer to Section 6 - Device Support 
for the specific attributes displayed for each device series. 

 
3 Main Window 
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4 Basic Operations 
 

This chapter discusses the basic operations within VLAN Manager windows. 

Topics 

• Selecting VLAN Definitions  
• Device Panel  
• VLAN Configuration Files  

 
4 Basic Operations 
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4.1 Selecting VLAN Definitions 
 

To select a VLAN definition in the VLAN Information Window or the Import VLAN dialog 
box, click on a row. To select multiple contiguous VLAN definitions, hold down the Shift 
key while clicking on the desired VLAN definitions. To select multiple non-contiguous 
VLAN definitions, hold down the Ctrl key while clicking on the desired VLAN definitions. 

 
4 Basic Operations 
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4.2 Device Panel 
 

A device panel that reflects the actual ports available on the target host is used to create 
or modify a VLAN definition. 

Note - The AT-A48/SC, AT-A48/MT and AT-A49 Expansion Modules for the AT-8350GB 
are not supported and will not show up on the device panel.  

Device Panel 

Note - For device models with redundant ports, use the RJ-45 ports to associate redundant 
ports to a VLAN.  

Note - Rel 2.9.1 of the AT-8800 series firmware does not return the correct connector type 
for the GBIC ports. As a result, ports 25 and 26 of the AT-8824 and ports 49 and 50 of the 
AT-8848 will always display a copper port image even if the GBIC that is physically inserted 
in the GBIC slot has a fiber interface.  

A port can be in any of the following states: 

Port Image State Description 

 Not Selected This port does not belong to the VLAN. 

 Selected 

This port is an untagged member of the VLAN. 

Note - For the AT-8600, AT-8700XL, AT-8800 and Rapier 
series, this port is a private untagged member of the Private 
VLAN. 

Note - For the AT-8900 and AT-9900 series, this port is either 
a private untagged member of the Private VLAN or a customer 
port of the Nested VLAN. 

 Flagged 

This port is a tagged member of the VLAN. 

Note - For the AT-8600, AT-8700XL, AT-8800 and Rapier 
series, this port is a private tagged member of the Private VLAN.

Note - For the AT-8900 and AT-9900 series, this port is either 
a private tagged member of the Private VLAN or a core member 
of the Nested VLAN. 
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Port Image State Description 

 Selected 

Note - For the AT-8600, AT-8700XL, AT-8800, Rapier, 
AT-8900 and AT-9900 series, this port is an uplink untagged 
member of the Private VLAN. 

Note - For the AT-9700, this port is a forbidden member 
of the VLAN. 

 Flagged 
Note - For the AT-8600, AT-8700XL, AT-8800, Rapier, 
AT-8900 and AT-9900 series, this port is an uplink tagged 
member of the Private VLAN. 

Clicking on a port will change its state as follows: 

Current State New State 

  

  

  

  

  

For the AT-8000S and AT-8000GS Series, a port can be in any of the following states: 

Port Image State Description 

 Not Selected This port does not belong to the VLAN. 

 Selected This port is an access untagged member of the VLAN. 

 T-Selected This port is a trunk untagged member of the VLAN. 

 T-Flagged This port is a trunk tagged member of the VLAN. 

 G-Selected This port is a general untagged member of the VLAN. 

 G-Flagged This port is a general tagged member of the VLAN. 

 Forbidden This port is a forbidden member of the VLAN. 
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Clicking on a port will change its state as follows: 

Current State New State 

  

  

  

  

  

  

 
 

4 Basic Operations 
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4.3 VLAN Configuration Files 
 

VLAN Configuration Files are Comma Separated Value (CSV) files containing VLAN 
definitions and are used by the Import VLAN and Export VLAN functions. 

The format of the VLAN Configuration File is as follows: 

VLAN_Entry1_Name, VLAN_Entry1_Identifier, attribute1, 
attribute2, etc. 

VLAN_Entry2_Name, VLAN_Entry2_Identifier, attribute1, 
attribute2, etc. 

and so on... 

VLAN attributes will differ in number, order and allowed values from one device series 
to another. Refer to Section 6 - Device Support for details on the attributes applicable 
to each device series. 

Note - VLAN Manager does not support the reserved word "ALL" for the Tagged Ports 
attribute. The VLAN definition will not be imported successfully if "ALL" is used.  

The following is an example of a VLAN Configuration File for the Rapier 24i device that 
contains two (2) VLAN definitions: 

prod,2,Private,"","10,12,14","12","10,14" 

test,3,Normal,"20-21","19,22","","" 

Note - Make sure that VLAN Names specified in VLAN Configuration Files do not contain 
commas or only 'space' character. VLAN Manager will ignore all device definitions that 
specify VLAN Names containing commas and only 'space' character. 

 

4 Basic Operations 
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5 Menus 
 

This chapter describes the items on VLAN Manager's main menu. 

Topics: 

• File  
• Edit  
• View  
• Tools  
• Help  

 
5 Menus 
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5.1 File 
 

The File menu lets you connect to and disconnect from a target host, check the properties 
of the target host, or exit VLAN Manager. 

Topics: 

• Open  
• Close  
• Properties  
• Exit  

5.1.1 Open 

This option allows you to specify a target host to connect to. When you select File > Open, 
the following dialog box appears. To connect to the device, fill in parameters in the dialog 
box, and click OK. 

Note - This option is not available if VLAN Manager is already connected to a target host. 

 
Open dialog box 

IP Address 
This is the Host Name or IP Address of the target host. 
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SNMP 
Version 

This drop down list allows you to select the SNMP version to use in managing 
the target device. 
  
Note - Before choosing "v2c" or "v3", make sure that the target device you are 
connecting to supports SNMP v2c and/or SNMP v3 respectively. 
  

Settings 
If the Version is set to "v1" or "v2c", this button opens the SNMP v1/v2c Settings 
window. Otherwise, if the Version is set to "v3", this button opens the SNMP v3 
Settings window. 
  

 
SNMP v1/v2c Settings dialog box 
  
Community Name 
The community strings to use in performing SNMP operations on the target host. 
There are two types of community strings for SNMP. Be sure to specify strings 
which match the ones configured on the target host. 
By default, the following strings are used: 
  
for the 'Get' operation 
public 
  
for the 'Set' operation 
private 
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SNMP v3 Settings dialog box 
  
User Account Name 
This is the SNMPv3 User Account to be used for accessing the MIB of the target 
device. Make sure to specify a User Account that has already been configured 
on the target device. 
  
Security Level 
This is the Security Level for the User Account Name that you have specified. 
Make sure to set the Security Level that is configured for the User Account Name 
on the target device. 
These are the available Security Levels: 
  
No Auth / No Priv 
This Security Level uses no authentication and no privacy. 
  
Auth / No Priv 
This Security Level uses authentication without privacy. 
  
Auth / Priv 
This Security Level uses authentication and privacy. 

 
Authentication Protocol 
If the Security Level is "Auth / No Priv" or " Auth / Priv", you need to specify an 
Authentication Protocol that is configured for the User Account Name on the target 
device. 
  
These are the available Authentication Protocols: 
  
MD5 
Use HMAC-MD5-96 protocol 
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SHA 
Use HMAC-SHA-96 protocol 

 
Authentication Password 
If the Security Level is "Auth / No Priv" or " Auth / Priv", you need to specify an 
Authentication Password that is configured for the User Account Name on the 
target device. 
  
Privacy Protocol 
If the Security Level is "Auth / Priv", you need to specify a Privacy Protocol. 
This is the available Privacy Protocol: 
  
DES 
Use Data Encryption Standard 
  
Privacy Password 
If the Security Level is "Auth / Priv", you need to specify a Privacy Password that 
is configured for the User Account Name on the target device. 
  

Login 
User Name 
This is the account name to be used to log in to the device. By default, this field 
is set to manager. This field is used for non-L2 devices only. For L2 devices, this field 
is ignored. 
  
Password 
This is the password for the account to be used. This field is used for non-L2 devices 
only. For L2 devices, this field is ignored. 
  

Retry 
Timeout 
The number of seconds VLAN Manager waits before it determines that the device 
is not responding. By default, this value is set to 5 seconds. 
  
Count 
The number of times VLAN Manager sends SNMP messages to the agent before 
giving up. By default, this value is set to 2 retries. 
  

5.1.2 Close 

This option closes the active connection with the device and empties the VLAN Information 
Window. 

Note - This option is not available if VLAN Manager is not yet connected to a device. 
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5.1.3 Properties 

The Properties dialog box allows you to modify the connection settings for the connected 
device. The Properties dialog box is identical to the Open dialog box used to open 
a connection. See Section 5.1.1 - Open. 

Note - This option is only available if VLAN Manager is already connected to a target host. 

5.1.4 Exit 
This option terminates connection to the target host and closes the VLAN Manager 
application.

 
5 Menus 
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5.2 Edit 
 

This option opens the Add VLAN dialog box that allows you to create a VLAN definition. 

Add VLAN dialog box 

5.2.1.1 Input Fields 

The Input Fields are the attributes that serve as VLAN creation parameters. These fields 
differ from one device family to another. In the illustration above, the device panel shown 
is for a Rapier 24i. Since the required Input Fields for the Rapier Family are Name, Identifier, 
and Operation Mode, these are the fields that are displayed in the Add VLAN dialog box. 

Refer to Section 6 - Device Support for details on the specific Input Fields available for each 
device family. 

5.2.1.2 Adding/Removing Ports 

You can add ports to or remove ports from a VLAN definition by clicking on the port 
images on the device panel. Refer to Section 4.2 - Device Panel for details on how to specify 
tagged and untagged ports, uplink untagged and uplink tagged ports, private untagged and 
private tagged ports, core and customer ports and to unselect ports. 
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Adding/Removing Ports 

In the illustration above, a new VLAN definition is being created for a Rapier 24i. The VLAN 
Name is "test" while its Identifier is "3". Ports 2 to 6 are untagged members while Port 1 
is a tagged member of the VLAN. 

5.2.1.3 OK Button 

The OK Button is disabled by default. It is only enabled when both the Name and Identifier 
fields are populated. When the OK button is clicked, VLAN Manager adds the new VLAN 
definition to the target host and updates the VLAN Information Window. 
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New VLAN definition added to VLAN Information Window 

After clicking the OK button, the new Add VLAN dialog will be closed and the new VLAN 
entry will be added to the Main window's Information Pane. 

5.2.1.4 Cancel Button 

The Cancel Button cancels the Add VLAN operation and closes the Add VLAN dialog box. 

5.2.2 Modify VLAN 

This option opens the Modify VLAN dialog box that allows you to change specific attributes 
of a VLAN. 

Note - This option is only available if a VLAN definition is selected. 

Refer to Section 4.1 - Selecting VLAN Definitions for details on how to select a VLAN 
definition. 
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Modify VLAN dialog box 

5.2.2.1 Input Fields 

The Input Fields are attributes of the VLAN definition to be modified. Depending on the 
device, one or more of the fields may be disabled and cannot be modified. 

Refer to Section 6 - Device Support for details on the specific attributes that can and cannot 
be modified for each device series. 

5.2.2.2 Modifying Ports 

You can add ports to or remove ports from a VLAN definition by clicking on the port 
images on the device panel. Refer to Section 4.2 - Device Panel for details on how to specify 
tagged and untagged ports, uplink untagged and uplink tagged ports, private untagged and 
private tagged ports, core and customer ports and to unselect ports. 

5.2.2.4 OK Button 

When the OK Button is clicked, VLAN Manager updates the VLAN definition in the target 
host and in the VLAN Information Window. 

5.2.2.5 Cancel Button 

The Cancel Button cancels the Modify VLAN operation and closes the Modify VLAN dialog 
box. 

5.2.3 Delete VLAN 

This option displays a delete VLAN confirmation dialog box. 

Note - This option is only available if a VLAN definition other than the default VLAN 
is selected. 

Note - You may select multiple VLAN definitions (except for the default VLAN) for deletion. 



 
 
 

       
      

AlliedView™-EMS 4.0.2  VLAN MANAGER USER’S GUIDE Page 26 of 77 

 

Refer to Section 4.1 - Selecting VLAN Definitions for details on how to select multiple 
VLAN definitions. 

 
Delete VLAN confirmation dialog box 

To remove the selected VLAN definition(s) from the target host and the VLAN Information 
Window, click Yes.  

5.2.4 Update VLAN Mode 

This option opens the Update VLAN Mode dialog box. 

Note - This option is only available to the AT-8000 Series, AT-8400, AT-8500 Series, 
and AT-9400 Series. 

 
Update VLAN Mode dialog box 

Mode 

Sets the VLAN Mode for the device. The available options are: 

• User Configured VLAN 
• Multiple VLAN 
• 802.1Q Multiple VLAN 

Uplink Port 

Designates a port as the uplink port that can be connected to a shared device. 

5.2.5 Import VLAN 

This option opens the Import VLAN dialog box that allows you to import VLAN definitions 
from a VLAN Configuration File, modify the VLAN entries, and overwrite the existing 
VLAN entries on the currently connected device. 
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Import VLAN dialog 

Note - Make sure that VLAN Names specified in VLAN Configuration Files do not contain 
commas or only 'space' character. VLAN Manager will ignore all device definitions that 
specify VLAN Names containing commas and only 'space' character. 

Note - SNMPv3: When an excluded VLAN record is included in the list of VLANs to import, 
the excluded VLAN record is deleted from the original VLAN configuration even if the 
Import VLAN operation does not succeed. This applies to the AT-9400 and AT-8500 series 
of devices. 

5.2.5.1 File Field and Browse Button 

You may specify a VLAN Configuration File (full path) in the File field. Alternatively, you can 
use the Browse button to locate the VLAN Configuration File to use. Once a valid VLAN 
Configuration File has been specified, the VLAN Definitions Table will be populated with the 
VLAN definitions contained in the file. You may then manually edit the definitions within the 
table. 

Note - Be sure to specify a VLAN Configuration File that contains VLAN entries suitable 
for the currently opened device. Otherwise, the Import VLAN function will fail. Refer to 
Section 4.3 - VLAN Configuration Files for more details. 

5.2.5.2 Add Button 

Clicking the Add Button adds an empty row to the VLAN Definitions Table. Once a row 
is added, it can be used to define a new VLAN. 
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5.2.5.3 Delete Button 

Clicking on the Delete Button removes the selected row(s) from the VLAN Definitions Table. 

5.2.5.4 OK Button 

Once the OK Button is clicked, VLAN Manager deletes all user-configured VLANs from the 
currently connected device and creates new user-configured VLANs based on the VLANs 
defined in the VLAN Definitions Table.  

5.2.6 Export VLAN 

This option opens a file browser dialog that allows you to specify a destination file and 
location in which to store exported VLAN definitions. Once a valid file and location is 
specified, VLAN Manager exports the VLAN definitions displayed in the VLAN Information 
Window to this file in CSV format. This file is then referred to as a VLAN Configuration File 
that can be used by the Import VLAN function.   

 
5 Menus 
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5.3 View 
 

The View menu lets you refresh the contents of the VLAN Information Window. 

Topics: 

• Refresh  

5.3.1 Refresh 

This option allows you to refresh the VLAN Information Window with the latest VLAN 
configuration of the currently connected device. 

Note - This option is only available if VLAN Manager is already connected to a target host. 

 
5 Menus 
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5.4 Tools 
 

The Tools menu lets you restart the currently connected device. 

Topics: 

• Restart  

5.4.1 Restart 

This option displays a restart confirmation dialog box. 

Note - This option is only available if VLAN Manager is already connected to a target host. 

 
Restart Confirmation dialog box 

To restart the currently connected device, click Yes. 

Note - During Restart operations, VLAN Manager may encounter a timeout error and 
display the message: "Unable to communicate. Confirm SNMP settings or login, and if the 
network is functional." To prevent this error message from appearing, go to File > 
Properties and increase the Retry Timeout value.
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5.5 Help 
 

The Help menu lets you view the online user's guide as well as some basic information 
about the application. 

Topics: 

• Index  
• About  

5.5.1 Index 

This option displays the main page of the online user's manual. 

5.5.2 About 

This option displays version and copyright information for VLAN Manager. It also displays 
a list of the currently supported devices. 

 
5 Menus 
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6 Device Support 
 

This section describes, on a per device series basis, the specific VLAN attributes displayed 
in the VLAN Information Window, the input fields that are available in the Add VLAN and 
Modify VLAN dialog boxes, and any known issues and/or operational notes. 

Topics: 

• AT-8000 Series  
• AT-8000GS Series  
• AT-8000S Series  
• AT-8300GB Series  
• AT-8400  
• AT-8500 Series 
• AT-8600 Series 
• AT-8700XL/AT-8800/Rapier Series 
• AT-8900/AT-9900/AT-x900-48 Series 
• AT-9000/24 and AT-9410GB 
• AT-9400 Series 
• AT-9700 Series 
• AT-9800/SwitchBlade Series 
• AT-9900s 
• AT-x600 Series 
• AT-x900-12XT/S 
• AT-x900-24X Series (AlliedWare) 
• AT-x900-24X Series (AlliedWare Plus) 
• SwitchBlade x908 
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6.1 AT-8000 Series 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  
• Notes  

6.1.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 
Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 

Mirror Port This is the number of the port on which all VLAN traffic 
is mirrored. 

Status 

This indicates the status of the VLAN. 

• active 
• not in service 
• not ready 
• create and go 
• create and wait 
• destroy 

6.1.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs have the following Input Fields: 

Input Field Valid Values Length 

Name 

-  Alphanumeric characters  
-  Underscore ("_")  
-  Dash ("-")  

Note - VLAN names must contain at least one (1) 
alphabet character. 

Note - "ALL" is a reserved word and cannot be used as 
a VLAN name. 

1 - 19 characters
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Input Field Valid Values Length 
Identifier (cannot be 
modified) 1 - 4094 - 

Mirror Port 

0-65535 

Note - The default value of 0 indicates that 
there is no port mirror defined for this VLAN. 

- 

6.1.3 Notes 

• An uplink port must be specified to change the VLAN Mode to "Multiple VLAN" 
or to "802.1Q Multiple VLAN". Specifying an incorrect port as the uplink port will 
cause VLAN Manager to lose connection with the device without any warning. 
Exercise caution. 
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6.2 AT-8000/8POE  
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  
• Notes  

6.2.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 
Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 

Status 

This indicates the status of the VLAN. 

• idle 
• operational 
• under-construction 
• not-operational 

6.2.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs display the following Input Fields: 

Input Field Valid Values Length 

Name 
-  Alphanumeric characters  
-  Underscore ("_")  
-  Dash ("-")  

0 - 20 characters

Identifier 1 - 4094 - 

6.2.3 Notes 

• Ports in the Default VLAN cannot be changed from untagged to tagged. 
• For the VLAN Name parameter, the current firmware version allows up to 20 

characters to be entered via SNMP and up to 32 characters via telnet. Since VLAN 
Manager is an SNMP-based application, the 20-character limit will apply to all 
operations involving VLAN Name. Moreover, attempting to perform Modify VLAN 
operation for VLANs with more than 20 character VLAN Names will not display any 
VLAN Names in the Modify VLAN dialog. 
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• The current firmware version does not allow VLAN definitions to be created 
without a VLAN name. As a result, the Add VLAN, Modify VLAN and Import VLAN 
operations will fail when the VLAN Name field is left blank. 

• The current firmware version does not allow VLAN definitions to be created / 
modified without a member port. As a result, port 1 is automatically flagged and 
added as a Tagged Port. 

• During an Import VLAN operation, VLAN Manager does not allow importing 
a VLAN with a VLAN ID of 1, doing so will result to failed import operation. 

• The current firmware version allows VLAN definitions with duplicate VLAN Names 
via telnet. Since VLAN Manager is an SNMP-based application, modifying VLANs 
with duplicate VLAN Names will result to an error message "VLAN Name or 
Identifier already exists.". Likewise, Import VLAN operation with duplicate VLAN 
Names will only accept the 1st VLAN entry and will fail the succeeding VLAN 
entries.  

• The current firmware version allows VLAN definitions with Extended ASCII 
characters within the VLAN Names. Since VLAN Manager is an SNMP-based 
application, Add VLAN, Modify VLAN and Import VLAN operations with Extended 
ASCII characters within the VLAN Name will not be allowed. Moreover, VLAN 
Names of VLANs with Extended ASCII characters created via telnet will be 
displayed as 'space' characters. 
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6.3 AT-8000GS Series  
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  
• Notes  

6.3.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 

Access (Untagged Ports) This is a list of the untagged member ports of the VLAN whose 
VLAN membership mode is set to access. 

Trunk (Tagged Ports) This is a list of the tagged member ports of the VLAN whose 
VLAN membership mode is set to trunk. 

Trunk (Untagged Ports) This is a list of the untagged member ports of the VLAN whose 
VLAN membership mode is set to trunk. 

General (Tagged Ports) This is a list of the tagged member ports of the VLAN whose 
VLAN membership mode is set to general. 

General (Untagged Ports) This is a list of the untagged member ports of the VLAN whose 
VLAN membership mode is set to general. 

Forbidden Ports This is a list of the forbidden member ports of the VLAN. 

6.3.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs have the following Input Fields: 

Input Field Valid Values Length 

Name 

-  Alphanumeric characters  
-  Special characters except the following:  

• Hash Sign ("#") 
• Period (".") 
• Colon (":") 
• Right Angle Bracket (">") 
• Question Mark ("?") 

1 - 32 characters

Identifier (cannot 
be modified) 2 - 4093 - 
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6.3.3 Notes 

• On Import VLAN, VLAN Manager will automatically trim leading/embedded/trailing 
spaces from VLAN Names. 

• If a port on a Non-Existing device is associated with a port channel, its tool tip text 
on the Device Panel will continue to show its interface name instead of its port 
channel number. 

• Attempting to perform any VLAN operation after modifying the uplink port of the 
device to 'Access-Untagged' or 'Trunk-Untagged' will result to an error message 
"Unable to communicate. Confirm valid SNMP settings or login, and if the network 
is functional" even if the device uplink port has been changed. Establish new 
connection with the device before performing any VLAN operation. 

• The Default VLAN cannot be imported into or exported from VLAN Manager. 
• VLAN Names that contain any of the invalid special characters may cause VLAN 

Manager to hang. To avoid this, do not use any of the invalid special characters when 
defining VLAN Names through the CLI. 

• VLAN name with prohibited character set in CLI will be displayed in Modify window 
except when the VLAN name or the last character of the VLAN name is a hash sign 
'#'. Attempting to modify a vlan name containing a hash sign # will result to an error 
message.  

• Ports or port channels that are General Untagged members of more than one 
VLAN cannot be associated as Trunk members of another VLAN. Attempting 
to do so will result to an error message depending on what the device will throw 
as an error message. 

• Ports or port channels that are Trunk or General members of more than one VLAN 
cannot be associated as Access members of another VLAN. Attempting to do so will 
result to an error message depending on what the device will throw as an error 
message. 

• During an Add/Modify VLAN operation, VLAN Manager processes and configures 
ports and port channels sequentially. When an error is encountered, succeeding 
ports and port channels are no longer processed. In a Modify VLAN operation, 
the port or port channel on which the error occurred will be returned to its 
original state. 

• Any attempt to modify the VLAN membership mode of a port or port channel 
that is an Access/Trunk/General Untagged member of the Default VLAN to a 
Trunk/General Tagged member will result in the error message: "Cannot associate 
tagged port or port channel to the default VLAN". 

• After initiating a Restart operation, VLAN Manager will continuously attempt 
to connect to the device for up to 1 minute until a connection is established. If a 
minute has elapsed and connection has still not been established, an error message 
will be displayed. 

• It may take a while for VLAN Manager to retrieve or save VLAN information 
from/to the AT-8000GS, especially if the device is in stack mode. 

• In stacked mode, VM will display the maximum number of devices supported in 
stack regardless of the actual device setup and will display a generic device image 
with maximum of 48 ports. A "Non-existing" label will be displayed on the device 
not present in the stack.  
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• The current firmware version allows you to pre-configure switches that may be 
added to the stack in the future. Pre-configured switches are identified by a "Non-
Existing" label that appears above the device panel in the Add VLAN and Modify 
VLAN dialog boxes. Ports on pre-configured switches can be included in a VLAN 
provided they are not members of a port channel. Any attempt to associate a pre-
configured switch port that is a member of a port channel to a VLAN will result in 
the error message: "Port <port no.> is a ghost port that belongs to a Port-Channel." 

 
6 Device Support 
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6.4 AT-8000S Series 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  
• Notes  

6.4.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 

Access (Untagged Ports) This is a list of the untagged member ports of the VLAN whose 
VLAN membership mode is set to access. 

Trunk (Tagged Ports) This is a list of the tagged member ports of the VLAN whose 
VLAN membership mode is set to trunk. 

Trunk (Untagged Ports) This is a list of the untagged member ports of the VLAN whose 
VLAN membership mode is set to trunk. 

General (Tagged Ports) This is a list of the tagged member ports of the VLAN whose 
VLAN membership mode is set to general. 

General (Untagged Ports) This is a list of the untagged member ports of the VLAN whose 
VLAN membership mode is set to general. 

Forbidden Ports This is a list of the forbidden member ports of the VLAN. 

6.4.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs have the following Input Fields: 

Input Field Valid Values Length 

Name 

-  Alphanumeric characters  
-  Special characters except the following:  

• Hash Sign ("#") 
• Period (".") 
• Colon (":") 
• Right Angle Bracket (">") 
• Question Mark ("?") 

1 - 32 characters

Identifier (cannot 
be modified) 2 - 4093 - 
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6.4.3 Notes 

• On Import VLAN, VLAN Manager will automatically trim leading/embedded/trailing 
spaces from VLAN Names. 

• If a port on a Non-Existing device is associated with a port channel, its tool tip text 
on the Device Panel will continue to show its interface name instead of its port 
channel number. 

• Attempting to perform any VLAN operation after modifying the uplink port of the 
device to 'Access-Untagged' or 'Trunk-Untagged' will result to an error message 
"Unable to communicate. Confirm valid SNMP settings or login, and if the network 
is functional" even if the device uplink port has been changed. Establish new 
connection with the device before performing any VLAN operation. 

• The Default VLAN cannot be imported into or exported from VLAN Manager. 
• VLAN Names that contain any of the invalid special characters may cause VLAN 

Manager to hang. To avoid this, do not use any of the invalid special characters when 
defining VLAN Names through the CLI. 

• VLAN name with prohibited character set in CLI will be displayed in Modify window 
except when the VLAN name or the last character of the VLAN name is a hash sign 
'#'. Attempting to modify a vlan name containing a hash sign # will result to an error 
message.  

• Ports or port channels that are General Untagged members of more than one 
VLAN cannot be associated as Trunk members of another VLAN. Attempting 
to do so will result to an error message depending on what the device will throw 
as an error message. 

• Ports or port channels that are Trunk or General members of more than one VLAN 
cannot be associated as Access members of another VLAN. Attempting to do so will 
result to an error message depending on what the device will throw as an error 
message. 

• During an Add/Modify VLAN operation, VLAN Manager processes and configures 
ports and port channels sequentially. When an error is encountered, succeeding 
ports and port channels are no longer processed. In a Modify VLAN operation, 
the port or port channel on which the error occurred will be returned to its 
original state. 

• Any attempt to modify the VLAN membership mode of a port or port channel 
that is an Access/Trunk/General Untagged member of the Default VLAN to a 
Trunk/General Tagged member or a Forbidden member will result in the error 
message: "Cannot associate tagged port or port channel to the default VLAN". 

• After initiating a Restart operation, VLAN Manager will continuously attempt 
to connect to the device for up to 1 minute until a connection is established. 
If a minute has elapsed and connection has still not been established, an error 
message will be displayed. 

• It may take a while for VLAN Manager to retrieve or save VLAN information 
from/to the AT-8000S, especially if the device is in stack mode. 

• In stacked mode, VM will display the maximum number of devices supported in 
stack regardless of the actual device setup and will display a generic device image 
with maximum of 48 ports. A "Non-existing" label will be displayed on the device 
not present in the stack.  
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• The current firmware version allows you to pre-configure switches that may be 
added to the stack in the future. Pre-configured switches are identified by a "Non-
Existing" label that appears above the device panel in the Add VLAN and Modify 
VLAN dialog boxes. Ports on pre-configured switches can be included in a VLAN 
provided they are not members of a port channel. Any attempt to associate a pre-
configured switch port that is a member of a port channel to a VLAN will result in 
the error message: "Port <port no.> is a ghost port that belongs to a Port-Channel." 

• VLAN Manager may intermittently fail and may return an error "Confirm valid IP 
Address, SNMP settings or login, and if the network is functional." when AT-8000S 
devices are in stacked mode. To prevent this, go to File -> Properties and increase 
the Retry Timeout value.  

 
6 Device Support 
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6.5 AT-8300GB Series 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  
• Notes  

6.5.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 

<Stack ID> - Tagged Ports This is a list of the tagged member ports of the VLAN that 
belong to a specific module on the stack. 

<Stack ID> - Untagged 
Ports 

This is a list of the untagged member ports of the VLAN that 
belong to a specific module on the stack. 

Status 

This indicates the status of the VLAN. 

• idle 
• operational 
• under-construction 
• not-operational 

6.5.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs display the following Input Fields: 

Input Field Valid Values Length 

Name 
-  Alphanumeric characters  
-  Underscore ("_")  
-  Dash ("-")  

0 - 32 characters

Identifier 1 - 4094 - 

6.5.3 Notes 
• Ports in the Default VLAN cannot be changed from untagged to tagged. 
• VLAN definitions that only contain tagged ports cannot be deleted. 
• The Retry Timeout value may have to be increased depending on the number of 

devices on the stack; otherwise, Add VLAN and Modify VLAN operations may fail. 

 
6 Device Support 
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6.6 AT-8400 Series 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  
• Notes  

6.6.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 

Type 

This indicates the type of the VLAN. 

• Port Based 
• MAC Based 
• Multiple 
• Multiple 802.1Q 

Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 

Status 

This indicates the status of the VLAN. 

• active 
• not in service 
• not ready 
• create and go 
• create and wait 
• destroy 

6.6.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs display the following Input Fields: 

Input Field Valid Values Length 

Name (cannot be 
modified) 

-  Alphanumeric characters  
-  Underscore ("_")  
-  Dash ("-")  

Note - VLAN names must contain at least one (1) 
alphabet character. 

1 - 19 characters
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Input Field Valid Values Length 
Identifier (cannot 
be modified) 1 - 4094 - 

6.6.3 Notes 

• An uplink port must be specified to change the VLAN Mode to "Multiple VLAN" 
or to "802.1Q Multiple VLAN". Specifying an incorrect port as the uplink port will 
cause VLAN Manager to lose connection with the devcie without any warning. 
Exercise caution. 

• Modifying the default VLAN definition will cause all other VLAN definitions 
to be deleted. When this happens, the device will need to be restarted. 

 
6 Device Support 
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6.7 AT-8500 Series 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  
• Notes  

6.7.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 
Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 

Status 

This indicates the status of the VLAN. 

• active 
• not in service 
• not ready 
• create and go 
• create and wait 
• destroy 

6.7.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs have the following Input Fields: 

Input Field Valid Values Length 

Name 

-  Alphanumeric characters  
-  Underscore ("_")  
-  Dash ("-")  

Note - VLAN names must contain at least one (1) 
alphabet character. 

1 - 20 characters

Identifier (cannot 
be modified) 1 - 4094 - 
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6.7.3 Notes 

• The current firmware version does not allow VLAN Manager to distinguish between 
Protected VLANs, Mac-based VLANs and standard Port-based VLANs. As a result, 
VLAN Manager will display and treat Protected VLANs and Mac-based VLANs as if 
they were standard Port-based VLANs. Furthermore, modifying a Protected VLAN 
or a Mac-based VLAN will convert that VLAN into a standard Port-based VLAN.  

• An uplink port must be specified to change the VLAN Mode to "Multiple VLAN" 
or to "802.1Q Multiple VLAN". Specifying an incorrect port as the uplink port 
will cause VLAN Manager to lose connection with the device without any warning. 
Exercise caution. 

• The current firmware version does not allow the Default VLAN to be modified. 
As a result, all VLAN Manager operations involving the Default VLAN will fail.  

• For 20-character VLAN Names entered via telnet, only the first 19 characters 
are registered in VLAN Manager.  

• AT-8550xx : Changing the VLAN Mode parameter setting from '802.1Q Multiple 
VLAN' to a different mode may result in the error message: "Unable to 
communicate. Confirm SNMP settings or login, and if the network is functional." 
However, VLAN Mode is still set to the new mode successfully. To prevent this 
error message from reappearing, go to File -> Properties and increase the Retry 
Timeout value.  

• For the VLAN Name parameter, the current firmware version allows up to 19 
characters to be entered via SNMP and up to 20 characters via telnet. Since VLAN 
Manager is an SNMP-based application, the 19-character limit will apply to all 
operations involving VLAN Name. 

• AT-8550xx : The current firmware version does not allow VLAN Manager to 
perform Add VLAN, Modify VLAN and Import VLAN operations that involve ports 
33 to 50. Attempting to perform such operations will result in the error message: 
"An error occurred during the operation. Error: Wrong value."  

• As a general rule, no two VLANs can have the same name. However, using an 
SNMPv3 account, adding a VLAN using a name that is already being used by another 
VLAN that has been excluded from the user account's view will be allowed. Once 
added, this VLAN will have a status of "not in service" and the only operation that 
can be performed on it will be Delete VLAN.  

• Changing the VLAN Mode parameter setting using the currently set VLAN Mode 
will result in the error message: "Error: Commit Failed."  

• During Restart operations, VLAN Manager may encounter a timeout error and 
display the message: "Unable to communicate. Confirm SNMP settings or login, 
and if the network is functional." To prevent this error message from reappearing, 
go to File -> Properties and increase the Retry Timeout value.  
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• The AT-8500 series does not allow multiple manager sessions. As such, if an active 
manager session is detected during a Restart operation, VLAN Manager will display 
the message: "The system has detected an active manager session. Please end the 
active manager session before restarting the device."  

A Restart operation cannot be performed using an SNMPv3 account that has no write 
access to the atiStkSwSysReset object. 

 
6 Device Support 
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6.8 AT-8600 Series 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  
• Notes  

6.8.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 
Operation Mode This indicates the operation mode of the VLAN. 
Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 
Uplink Port This identifies the uplink port of the VLAN. 
Private Ports This is a list of the private ports of the VLAN. 

Status 

This indicates the status of the VLAN. 

• dynamic 
• static 

6.8.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs have the following Input Fields: 

Input Field Valid Values Length 

Name (cannot be 
modified) 

-  Alphanumeric characters  
-  Underscore ("_")  
-  Dash ("-")  

Note - VLAN names must contain at least one (1) 
alphabet character. 

Note - "ALL" is a reserved word and cannot be used 
as a VLAN name. 

1 - 15 characters 
 

If the software 
release version is 
2.7.3 or higher:

1 - 32 characters 

Identifier (cannot 
be modified) 1 - 4094 - 
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Input Field Valid Values Length 
Operation Mode 
(cannot be 
modified) 

-  Normal  
-  Private  
-  Protected  

- 

6.8.3 Notes 

• When importing the default VLAN, VLAN Manager disregards the values specified 
for Untagged Ports. 

• During an Import VLAN operation, VLAN Manager will ignore the values specified 
for the Uplink Port and Private Ports fields if the value specified for the Operation 
Mode field is "Normal" or "Protected". 

 
6 Device Support 
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6.9 AT-8700XL/AT-8800/Rapier Series 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  
• Notes  

6.9.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 
Operation Mode This indicates the operation mode of the VLAN. 
Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 
Uplink Port This identifies the uplink port of the VLAN. 
Private Ports This is a list of the private ports of the VLAN. 

Status 

This indicates the status of the VLAN. 

• dynamic 
• static 

6.9.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs have the following Input Fields: 

Input Field Valid Values Length 

Name (cannot be 
modified) 

-  Alphanumeric characters  
-  Underscore ("_")  
-  Dash ("-")  

Note - VLAN names must contain at least one (1) 
alphabet character. 

Note - "ALL" is a reserved word and cannot be used 
as a VLAN name. 

1 - 15 characters 
 

If the software 
release version is 
2.7.3 or higher:

1 - 32 characters 

Identifier (cannot 
be modified) 1 - 4094 - 



 
 
 

       
      

AlliedView™-EMS 4.0.2  VLAN MANAGER USER’S GUIDE Page 52 of 77 

 

Input Field Valid Values Length 

Operation Mode 
(cannot be 
modified) 

AT-8700XL:  

Rel 2.6.4-00 to Rel 2.6.4-02 - field not 
applicable 
Rel 2.6.4-03 or later - 
Normal/Protected/Private 

AT-8800:  

Rel 2.6.3 or lower - Normal/Protected 
Rel 2.6.4 - Normal/Private 
Rel 2.6.4-04 or later - 
Normal/Protected/Private 

Rapier:  

Rel 2.6.1-10 to 2.6.1-12 -
Normal/Protected/Private 
Rel 2.6.3 or lower - Normal/Protected 
Rel 2.6.4 -Normal/Private 
Rel 2.6.4-04 or later - 
Normal/Protected/Private 

- 

6.9.3 Notes 

• When importing the default VLAN, VLAN Manager disregards the values specified 
for Untagged Ports.  

• During an Import VLAN operation, VLAN Manager will ignore the values specified 
for the Uplink Port and Private Ports fields if the value specified for the Operation 
Mode field is "Normal" or "Protected".  

• Modifying a Private VLAN to include an uplink port that is a tagged member of the 
Default VLAN will result in an error. However, the uplink port will still be added 
successfully.  

 
6 Device Support 
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6.10 AT-8900/AT-9900/AT-x900-48 Series 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  
• Notes  

6.10.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 
Operation Mode This indicates the operation mode of the VLAN. 

Type 

This indicates the type of the VLAN. 

• Port-based 
• Multiple Type 

Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 
Uplink Port This identifies the uplink port of the VLAN. 
Private Ports This is a list of the private ports of the VLAN. 
Core Ports This is a list of the core ports of the VLAN. 
Customer Ports This is a list of the customer ports of the VLAN. 

Status 

This indicates the status of the VLAN. 

• dynamic 
• static 

6.10.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs have the following Input Fields: 
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Input Field Valid Values Length 

Name (cannot be 
modified) 

-  Alphanumeric characters  
-  Underscore ("_")  
-  Dash ("-")  

Note - VLAN names must contain at least one (1) 
alphabet character. 

Note - "ALL" is a reserved word and cannot be used 
as a VLAN name. 

AT-8900:  

1 - 15 characters 
 

If the software 
release version is 
2.7.3 or higher:

1 - 32 characters 

AT-9900/ 
AT-x900-48:  

1 - 32 characters 
Identifier (cannot 
be modified) 1 - 4094 - 

Operation Mode 
(cannot be 
modified) 

-  Normal  
-  Private  
-  Nested  

- 

6.10.3 Notes 

• AT-x900-48FS: The current firmware version does not allow VLAN Manager to 
display the correct image for SFP module 'AT-SPFXBD-LC-13'. As a result, the SFP 
image that will be displayed is the generic SFP Fiber image.  

• When adding/modifying a Nested VLAN, specifying a port that is already a member 
of an existing Normal VLAN will not generate any error. However, the specified 
port will be ignored. In addition, during modification, existing member ports having 
the same status (tagged/untagged) as the specified port will be deleted.  

• When importing the default VLAN, VLAN Manager disregards the values specified 
for Untagged Ports.  

• During an Import VLAN operation, VLAN Manager will ignore the values specified 
for certain fields depending on the value specified for the Operation Mode field: 

o If Operation Mode is "Normal" - Uplink Port, Private Ports, Core Ports 
and Customer Ports 

o If Operation Mode is "Private" - Core Ports and Customer Ports 
o If Operation Mode is "Nested" - Tagged Ports, Untagged Ports, Uplink Port 

and Private Ports 
• User-created VLANs are classified as Multiple Type VLANs. There are three 

possible VLAN associations for a Multiple Type VLAN: IP Subnet, Protocol and Port. 
Currently, VLAN Manager only supports Port association. As a result, when 
attempting to modify a VLAN with an association other than Port, VLAN Manager 
automatically changes the association of that VLAN to Port.  
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• When adding/modifying a Nested VLAN, specifying 2 or more core ports where one 
of the specified ports is already a member of an existing Nested VLAN will result 
in the error message: "Must return port <n> to the default VLAN as untagged port 
based." 

 
6 Device Support 
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6.11 AT-9000/24 and AT-9410GB 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  
• Notes  

6.11.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 
Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 

Status 

This indicates the status of the VLAN. 

• idle 
• operational 
• under-construction 
• not-operational 

6.11.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs display the following Input Fields: 

Input Field Valid Values Length 

Name 
-  Alphanumeric characters  
-  Underscore ("_")  
-  Dash ("-")  

0 - 32 characters

Identifier 1 - 4094 - 

6.11.3 Notes 

• The current firmware version does not allow VLAN definitions to be created 
without a VLAN name. As a result, the Add VLAN, Modify VLAN and Import VLAN 
operations will fail when the VLAN Name field is left blank. 

• Ports in the Default VLAN cannot be changed from untagged to tagged. 
• VLAN definitions that only contain tagged ports cannot be deleted. 
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• The current firmware version does not allow VLAN definitions to be created / 
modified without a member port. As a result, port 1 is automatically flagged and 
added as a Tagged Port. 

• During an Import VLAN operation, VLAN Manager does not allow importing 
a VLAN with a VLAN ID of 1, doing so will result to failed import operation. 

 
6 Device Support 



 
 
 

       
      

AlliedView™-EMS 4.0.2  VLAN MANAGER USER’S GUIDE Page 58 of 77 

 

6.12 AT-9400 Series 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  
• Notes  

6.12.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 

Type 

This indicates the type of the VLAN. 

• Port-based 
• Mac-based 

Note - VLAN Type is only available to Layer 3 models with 
firmware version of 3.1.0 or higher. 

Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 

Status 

This indicates the status of the VLAN. 

• idle 
• operational 
• under-construction 
• not-operational 

6.12.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs have the following Input Fields: 

Input Field Valid Values Length 

Name 

-  Alphanumeric characters  
-  Underscore ("_")  
-  Dash ("-")  

Note - VLAN names must contain at least one (1) 
alphabet character. 

1 - 20 characters

Identifier (cannot 
be modified) 1 - 4094 - 



 
 
 

       
      

AlliedView™-EMS 4.0.2  VLAN MANAGER USER’S GUIDE Page 59 of 77 

 

Input Field Valid Values Length 

Type (cannot be 
modified) 

-  Port-based  
-  Mac-based  

Note - VLAN Type is only available to Layer 3 models 
with firmware version of 3.1.0 or higher. 

- 

6.12.3 Notes 

• AT-9400 L3 Models: The current firmware version does not allow VLAN Manager 
to distinguish Protected VLANs. As a result, VLAN Manager will display and treat 
Protected VLANs as if they were standard Port-based VLAN or Mac-based VLAN 
depending on the type of existing VLAN prior to Protected VLAN. Attempting to 
modify a Protected VLAN will result to an error message: "An error occured during 
operation. Error. You are trying to modify a Protected VLAN. Modification made 
will not be applied." Furthermore, modifying a Protected VLAN will convert that 
VLAN into a standard Port-based VLAN or Mac-based VLAN depending also 
on the type of existing VLAN prior to modified Protected VLAN.  

Ex.  

o In CLI, VLAN record#1 is a Port-based VLAN and VLAN record#2 is a 
Protected VLAN. In VLAN Manager, VLAN record#2 will be displayed 
as standard Port-based VLAN. Furthermore, modifying VLAN record#2 
will be converted into a standard Port-based VLAN. 

o In CLI, VLAN record#7 is a Mac-based VLAN and VLAN record#8 is a 
Protected VLAN. In VLAN Manager, VLAN record#8 will be displayed 
as Mac-based VLAN. Furthermore, modifying VLAN record#8 will be 
converted into a Mac-based VLAN. 

• An uplink port must be specified to change the VLAN Mode to "Multiple VLAN" 
or to "802.1Q Multiple VLAN". Specifying an incorrect port as the uplink port will 
cause VLAN Manager to lose connection with the device without any warning. 
Exercise caution. 

• AT-9400 L2 Models: The current firmware version does not allow VLAN Manager 
to distinguish Protected VLANs, Mac-based VLANs and standard Port-based VLANs 
from each other. As a result, VLAN Manager will display and treat Protected VLANs 
and Mac-based VLANs as if they were standard Port-based VLANs. Furthermore, 
modifying a Protected VLAN or a Mac-based VLAN will convert that VLAN into 
a standard Port-based VLAN. 

• AT-9424T/PoE: Firmware version "AT-S63 version 3.2.1 patch 05" does not allow 
VLAN Manager to add a MAC-based VLAN. Attempting to do so will result to an 
error message: "Error: Commit Failed". 

• The current firmware version does not allow the Default VLAN to be modified. 
As a result, all VLAN Manager operations involving the Default VLAN will fail.  

• For 20-character VLAN Names entered via telnet, only the first 19 characters are 
registered in VLAN Manager.  
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• For the VLAN Name parameter, the current firmware version allows up to 19 
characters to be entered via SNMP and up to 20 characters via telnet. Since VLAN 
Manager supports the AT-9400 series via SNMP, the 19-character limit will apply 
to all operations involving VLAN Name.  

• AT-9400 L3 Models: Changing the VLAN Mode parameter setting from 'Multiple 
VLAN' or '802.1Q Multiple VLAN' to 'User Configured VLAN' may result in 
unpredictable behavior.  

• Using an SNMPv3 account, adding a VLAN using a name that has been excluded 
from the user account's view will result in an error message and the VLAN will 
not be added.  

• Changing the VLAN Mode parameter setting using the currently set VLAN Mode 
will result in the error message: "Error: Commit Failed."  

• Changing the VLAN Mode parameter setting from '802.1Q Multiple VLAN' to a 
different mode may result in the error message: "Unable to communicate. Confirm 
SNMP settings or login, and if the network is functional." However, VLAN Mode 
is still set to the new mode successfully. To prevent this error message from 
reappearing, go to File > Properties and increase the Retry Timeout value.  

• The current firmware version does not allow VLAN Manager to retrieve the device 
VLAN information using an SNMPv3 account with no view access in any of the 
following mib object: VLAN Name, Tagged/Untagged Ports, and Status.  

• An SNMPv3 account with "No Write" access will still allow users to configure the 
Update VLAN Mode operation. 

• Using an SNMPv3 account with "No Write" access, attempting to perform a Restart 
and Import VLAN operation will result in an error message: "An error occurred 
during the operation. No Access." 

• After initiating a Restart operation, VLAN Manager will continuously attempt 
to connect to the device for up to 1 minute until a connection is established. If a 
minute has elapsed and connection has still not been established, an error message 
will be displayed. 

• AT-9448T/SP: Changing the VLAN Mode to "802.1Q Multiple VLAN" using the 
latest firmware may result in unpredictable behavior. Attempting to do so may cause 
the device to reboot and VLAN Manager may intermittently fail to access the device 
and will return an error message: "An error occurred during the operation. 
Error: VLAN Information retrieval failed.". 

 
6 Device Support 
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6.13 AT-9700 Series 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  
• Notes  

6.13.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 

Type 

This indicates the type of the VLAN. 

• 1q_vlan 
• protocol 

Advertisement 

This specifies that the VLAN is able to join GVRP. 

• Enabled 
• Disabled 

Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 
Forbidden Ports This is a list of the forbidden member ports of the VLAN. 

6.13.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs have the following Input Fields: 

Input Field Valid Values Length 

Name (cannot be 
modified) 

If the software release version is 2.03 or lower:  
-  Alphanumeric characters  
-  Other characters except double quote (") 
 
If the software release version is 3.03:  
-  Alphanumeric characters  
-  Underscore ("_")  
-  Dash ("-")  

1 - 32 characters
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Input Field Valid Values Length

Identifier (cannot be modified) -  2 - 4094  - 

Advertisement (cannot be modified if VLAN Type is Protocol) -  Enabled  
-  Disabled  

- 

6.13.3 Notes 

• The XFP slots on the device image will always show XFP images regardless of 
whether or not XFP transceivers are physically present in the slots. 

• The current firmware version allows a maximum of 32 characters for the VLAN 
Name parameter. When adding ports 1 and/or 2 as tagged/untagged ports of a 
VLAN whose name is of length 32, an additional character is appended to the name 
thereby causing the name to exceed 32 characters. When this happens, problems 
may be encountered while attempting to modify or delete this VLAN. 

• The current firmware version allows you to pre-configure switches that may be 
added to the stack in the future. Pre-configured switches are identified by a “Non-
Existing” label that appears above the device panel in the Add VLAN and Modify 
VLAN dialog boxes. Ports on pre-configured switches can be included in a VLAN 
but only those marked as “untagged” or “forbidden” will appear on the VLAN 
Information Window. Ports marked as “tagged” will not appear. They will appear 
only when a physical switch, whose box id matches the box id of the pre-configured 
switch to which the tagged ports belong, is added to the stack. 

• Deleting a VLAN containing untagged port members that are Forbidden member 
ports of the Default VLAN will result in the error message “Command: delete vlan 
<vlan name> Fail!” However, performing a Refresh operation will show that the 
VLAN was successfully removed.    

 
6 Device Support 
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6.14 AT-9800/SwitchBlade Series 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  
• Notes  

6.14.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 
Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 

Type 

This indicates the type of the VLAN. 

• Port-based 
• IP subnet-based 
• Protocol-based 
• MAC address-based 
• Limited protocol-based 

Status 

This indicates the status of the VLAN. 

• dynamic 
• static 

6.14.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs have the following Input Fields: 

Input Field Valid Values Length 

Name (cannot be 
modified) 

-  Alphanumeric characters  
-  Underscore ("_")  
-  Dash ("-")  

Note - VLAN names must contain at least one (1) 
alphabet character. 

Note - "ALL" is a reserved word and cannot be used as 
a VLAN name. 

1 - 15 characters 
 

If the software 
release version is 
2.7.1 or higher:

1 - 32 characters 
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Input Field Valid Values Length 
Identifier (cannot 
be modified) 

-  1 - 4090 (AT-9800 Series)  
-  1 - 4078 (SwitchBlade Series)  - 

6.14.3 Notes 

• When importing the default VLAN, VLAN Manager disregards the values specified 
for Untagged Ports. 

 
6 Device Support 
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6.15 AT-9900s Series 
 

Topics: 

• VLAN Information Window 
• Add/Modify VLAN Dialogs 
• Notes 

6.15.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 
Operation Mode This indicates the operation mode of the VLAN. 

Type 

This indicates the type of the VLAN. 

• Port-based 
• Multiple Type 

Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 
Uplink Port This identifies the uplink port of the VLAN. 
Private Ports This is a list of the private ports of the VLAN. 
Core Ports This is a list of the core ports of the VLAN. 
Customer Ports This is a list of the customer ports of the VLAN. 

Status 

This indicates the status of the VLAN. 

• dynamic 
• static 

6.15.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs have the following Input Fields: 
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Input Field Valid Values Length 

Name (cannot be 
modified) 

-  Alphanumeric characters  
-  Underscore ("_")  
-  Dash ("-")  

Note - VLAN names must contain at least one (1) 
alphabet character. 

Note - "ALL" is a reserved word and cannot be used as 
a VLAN name. 

1 - 32 characters 

Identifier (cannot 
be modified) 1 - 4094 - 

Operation Mode 
(cannot be 
modified) 

-  Normal  
-  Private  
-  Nested  

- 

6.15.3 Notes 

• When adding/modifying a Nested VLAN, specifying a port that is already a member 
of an existing Normal VLAN will not generate any error. However, the specified 
port will be ignored. In addition, during modification, existing member ports having 
the same status (tagged/untagged) as the specified port will be deleted.  

• When importing the default VLAN, VLAN Manager disregards the values specified 
for Untagged Ports.  

• During an Import VLAN operation, VLAN Manager will ignore the values specified 
for certain fields depending on the value specified for the Operation Mode field: 

o If Operation Mode is "Normal" - Uplink Port, Private Ports, Core Ports and 
Customer Ports 

o If Operation Mode is "Private" - Core Ports and Customer Ports 
o If Operation Mode is "Nested" - Tagged Ports, Untagged Ports, Uplink Port 

and Private Ports 
• User-created VLANs are classified as Multiple Type VLANs. There are three 

possible VLAN associations for a Multiple Type VLAN: IP Subnet, Protocol and Port. 
Currently, VLAN Manager only supports Port association. As a result, when 
attempting to modify a VLAN with an association other than Port, VLAN Manager 
automatically changes the association of that VLAN to Port.  

When adding/modifying a Nested VLAN, specifying 2 or more core ports where one of the 
specified ports is already a member of an existing Nested VLAN will result in the error 
message: "Must return port <n> to the default VLAN as untagged port based."

 
6 Device Support 



 
 
 

       
      

AlliedView™-EMS 4.0.2  VLAN MANAGER USER’S GUIDE Page 67 of 77 

 

6.16 AT-x600 Series 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  
• Notes  

6.16.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 
Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 

Status 

This indicates the status of the VLAN. 

• active 
• noInService 
• notReady 
• createAndGo 
• createAndWait 
• destroy 

6.16.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs have the following Input Fields: 

Input Field Valid Values Length 

Name 

-  Alphanumeric characters  
-  Special characters except the following:  

• Question Mark ("?") 
• Space (" ") 

Note - VLAN names must contain at least one (1) 
alphabet character. 

1 - 32 characters

Identifier (cannot 
be modified) 1 - 4094 - 
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6.16.3 Notes 

• VLAN Manager does not display the tagged ports set in the Default VLAN if the 
port is not a member of another VLAN. Port must be in Untagged state in other 
VLAN in order to set it to Tagged state in the default VLAN.  

• It may take a while for VLAN Manager to retrieve or save VLAN information 
from/to the device if the device is in stacked mode. 

• VLAN Manager may intermittently fail to access the device even if the device is up. 
• Port must be in Untagged state in other VLAN in order to remove it from the 

default VLAN. If a port is not Untagged in other VLAN, user would not be able 
to remove it from the default VLAN. 

• The current firmware version will allow VLAN Manager to retrieve the device 
VLAN information using an SNMPv3 account that has no read access configuration. 

 
6 Device Support 
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6.17 AT-x900-12XT/S 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  
• Notes  

6.17.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 
Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 

Status 

This indicates the status of the VLAN. 

• active 
• noInService 
• notReady 
• createAndGo 
• createAndWait 
• destroy 

6.17.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs have the following Input Fields: 

Input Field Valid Values Length 

Name 

-  Alphanumeric characters  
-  Special characters except the following:  

• Question Mark ("?") 
• Space (" ") 

Note - VLAN names must contain at least one (1) 
alphabet character. 

1 - 32 characters

Identifier (cannot 
be modified) 1 - 4094 - 
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6.17.3 Notes 

• VLAN Manager does not display the tagged ports set in the Default VLAN if the 
port is not a member of another VLAN. Port must be in Untagged state in other 
VLAN in order to set it to Tagged state in the default VLAN.  

• It may take a while for VLAN Manager to retrieve or save VLAN information 
from/to the device if the device is in stacked mode. 

• VLAN Manager may intermittently fail to access the device even if the device is up. 
• Port must be in Untagged state in other VLAN in order to remove it from the 

default VLAN. If a port is not Untagged in other VLAN, user would not be able 
to remove it from the default VLAN. 

• The current firmware version will allow VLAN Manager to retrieve the device 
VLAN information using an SNMPv3 account that has no read access configuration. 

 
6 Device Support 
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6.18 AT-x900-24X Series (AlliedWare Plus) 
 

Topics: 

• VLAN Information Window 
• Add/Modify VLAN Dialogs 
• Notes 

6.18.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 
Operation Mode This indicates the operation mode of the VLAN. 

Type 

This indicates the type of the VLAN. 

• Port-based 
• Multiple Type 

Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 
Uplink Port This identifies the uplink port of the VLAN. 
Private Ports This is a list of the private ports of the VLAN. 
Core Ports This is a list of the core ports of the VLAN. 
Customer Ports This is a list of the customer ports of the VLAN. 

Status 

This indicates the status of the VLAN. 

• dynamic 
• static 

6.18.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs have the following Input Fields: 
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Input Field Valid Values Length 

Name (cannot be 
modified) 

-  Alphanumeric characters  
-  Underscore ("_")  
-  Dash ("-")  

Note - VLAN names must contain at least one (1) 
alphabet character. 

Note - "ALL" is a reserved word and cannot be used as 
a VLAN name. 

1 - 32 characters 

Identifier (cannot 
be modified) 1 - 4094 - 

Operation Mode 
(cannot be 
modified) 

-  Normal  
-  Private  
-  Nested  

- 

6.18.3 Notes 

• When adding/modifying a Nested VLAN, specifying a port that is already a member 
of an existing Normal VLAN will not generate any error. However, the specified 
port will be ignored. In addition, during modification, existing member ports having 
the same status (tagged/untagged) as the specified port will be deleted.  

• When importing the default VLAN, VLAN Manager disregards the values specified 
for Untagged Ports.  

• During an Import VLAN operation, VLAN Manager will ignore the values specified 
for certain fields depending on the value specified for the Operation Mode field: 

o If Operation Mode is "Normal" - Uplink Port, Private Ports, Core Ports 
and Customer Ports 

o If Operation Mode is "Private" - Core Ports and Customer Ports 
o If Operation Mode is "Nested" - Tagged Ports, Untagged Ports, Uplink Port 

and Private Ports 
• User-created VLANs are classified as Multiple Type VLANs. There are three 

possible VLAN associations for a Multiple Type VLAN: IP Subnet, Protocol and Port. 
Currently, VLAN Manager only supports Port association. As a result, when 
attempting to modify a VLAN with an association other than Port, VLAN Manager 
automatically changes the association of that VLAN to Port.  

• When adding/modifying a Nested VLAN, specifying 2 or more core ports where one 
of the specified ports is already a member of an existing Nested VLAN will result 
in the error message: "Must return port <n> to the default VLAN as untagged port 
based."  
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6.19 AT-x900-24X Series (AlliedWare Plus) 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  
• Notes  

6.19.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 
Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 

Status 

This indicates the status of the VLAN. 

• active 
• noInService 
• notReady 
• createAndGo 
• createAndWait 
• destroy 

6.19.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs have the following Input Fields: 

Input Field Valid Values Length 

Name 

-  Alphanumeric characters  
-  Special characters except the following:  

• Question Mark ("?") 
• Space (" ") 

Note - VLAN names must contain at least one (1) 
alphabet character. 

1 - 32 characters

Identifier (cannot 
be modified) 1 - 4094 - 
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6.19.3 Notes 

• VLAN Manager does not display the tagged ports set in the Default VLAN if the 
port is not a member of another VLAN. Port must be in Untagged state in other 
VLAN in order to set it to Tagged state in the default VLAN.  

• It may take a while for VLAN Manager to retrieve or save VLAN information 
from/to the device if the device is in stacked mode. 

• VLAN Manager may intermittently fail to access the device even if the device is up. 
• Port must be in Untagged state in other VLAN in order to remove it from the 

default VLAN. If a port is not Untagged in other VLAN, user would not be able 
to remove it from the default VLAN. 

• The current firmware version will allow VLAN Manager to retrieve the device 
VLAN information using an SNMPv3 account that has no read access configuration. 

• VLAN Manager may intermittently return an error message when setting the ports 
to Tagged or Untagged if the device is in stacked mode.  
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6.20 SwitchBlade x908 
 

Topics: 

• VLAN Information Window  
• Add/Modify VLAN Dialogs  
• Notes  

6.20.1 VLAN Information Window 

The VLAN Information Window displays the following attributes for each VLAN definition: 

Column Name Description 
Name This is the name of the VLAN. 
Identifier This is the unique identifier of the VLAN. 
Tagged Ports This is a list of the tagged member ports of the VLAN. 
Untagged Ports This is a list of the untagged member ports of the VLAN. 

Status 

This indicates the status of the VLAN. 

• active 
• noInService 
• notReady 
• createAndGo 
• createAndWait 
• destroy 

6.20.2 Add/Modify VLAN Dialogs 

The Add/Modify VLAN Dialogs have the following Input Fields: 

Input Field Valid Values Length 

Name 

-  Alphanumeric characters  
-  Special characters except the following:  

• Question Mark ("?") 
• Space (" ") 

Note - VLAN names must contain at least one (1) 
alphabet character. 

1 - 32 characters

Identifier (cannot 
be modified) 1 - 4094 - 
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6.20.3 Notes 

• VLAN Manager does not display the tagged ports set in the Default VLAN if the 
port is not a member of another VLAN. Port must be in Untagged state in other 
VLAN in order to set it to Tagged state in the default VLAN.  

• The current firmware version will allow VLAN Manager to retrieve the device 
VLAN information using an SNMPv3 account that has no read access configuration. 

• It may take a while for VLAN Manager to retrieve or save VLAN information 
from/to the device if the device is in stacked mode. 

• VLAN Manager may intermittently fail to access the device even if the device is up. 

• Port must be in Untagged state in other VLAN in order to remove it from the 
default VLAN. If a port is not Untagged in other VLAN, user would not be able 
to remove it from the default VLAN. 
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